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1. Introduction 
This quick start guide assists a reviewer in evaluating compliance with an IESVE model.    

 

Software Engine Validation 

The <Virtual Environment> has been assessed against a number of global standards, including ASHRAE Standard 

140.  IESVE is fully validated under ASHRAE Standard 140 and have published the results for all current versions.  

For more information about software validations and approval, as well as copies of ASHRAE Standard 140 

results, please visit http://www.iesve.com/software/software-validation. Additionally, IESVE is approved by the 

US Department of Energy for Federal Incentives – IRS Code 179D. 

 

Step 1: Installation & Activation of IESVE Software  

You will receive an email with instructions on how to download the current version of the <Virtual Environment> 

software. This will contain a link that gives access to the software and full instructions on how to download and 

install. 

To request keys simply run the software and click through help >> request licence keys and enter your details, 

leave activation code field blank and choose action: request free trial and click send request. 

Once the request is sent, the IES Keys team will process the request and send out a confirmation email.  Follow 

the directions within the email to activate the software.  For additional support, email the IES Keys team at 

keys@iesve.com. For any single-location network license access, please see the following URL for installation 

details http://www.iesve.com/software/download/requesting_licence_keys.pdf. 

Multiple versions of IESVE can be supported simultaneously and all older versions of IESVE software are available 

for download at the URL: http://www.iesve.com/software/download/ve-for-engineers/archive.  When opening 

older software versions, the DLL files will need to be registered before that older version can be opened. To do 

this, run the IESFIX.exe from the installations ‘apps’ folder.   

 

  

http://www.iesve.com/software/software-validation
mailto:keys@iesve.com
http://www.iesve.com/software/download/requesting_licence_keys.pdf
http://www.iesve.com/software/download/ve-for-engineers/archive


 

 

 

Step 2: Weather File Directory 

To perform analysis in IESVE, it is also necessary to install the appropriate weather files and design day files 

(*.epw and *.ddy) should be copied to the following location: 

C:\Program Files (x86)\IES\Shared Content\Weather 

 

Figure 1: Weather File Directory 

 

Opening an IESVE Model 

Once IESVE Software has been opened, a number of licensed Applications should be shown (see section 01 

below).  To open an IESVE model, first save the model file(s) to your local directory.  

 



 

 

 

Figure 2: IESVE Software Landscape 

IES <Virtual Environment> model files are most commonly shared in an archive, or cabinet file (*.cab).  Before 

opening the archived model, it is important to note which version of IESVE is installed and in which version the 

archived model was created.  To determine which version of IESVE is installed, simply select Help -> About VE 

within the software menus at the top of the screen to generate the following: 

 

Figure 3: IESVE Version 

To determine the version in which the archived model was created.  Most archived model files will be named to 

include the software version, either at the beginning or end of the file name.  For example, a file named 

“[VE2016]_Example Project.cab” was created in IESVE 2016.  Models created in older software versions may be 

opened newer software versions, but newer models cannot be opened in older versions.  Opening an older 

model in a newer version of the software requires upgrading the model and is not recommended when 

reviewing a model.  Multiple software versions may be installed on a single computer at the same time. 

Once the version of the software and the version of the archived model are aligned, open the archived model 

by going to File -> Archive -> Extract as shown below: 



 

 

 

 

Figure 4: IESVE Model Extract 

Select the model archive file (*.cab) and choose a location for extracting the model files: 

 

Figure 5: IESVE Archive Project 

An IESVE models will consist of a model folder containing multiple files and subfolders.  The model folder should 

be saved on the local drive and should not be a subfolder of another model, as this can cause model corruption.  

Take care in selecting the location for model files, especially if simulations are to be performed. 



 

 

 

 

Figure 6: IESVE Project Directory 

Extracting a model archive creates a model folder and all necessary subfolders and files.  Any subsequent edits 

made to the model will be contained with the model folder and will not change the model archive in any way.  

As such, the same model archive can be extracted any time and produce the same resulting model. 

The 8,760 simulation results files are saved in the vista folder. There should be one proposed file, often 

beginning with the letter ‘p’, and one baseline/standard result file, often beginning with the letter ‘b’. The IESVE 

energy model can be zipped or extracted to a .cab file with or without the results file.  

 



 

 

 

2. Model Review – Inputs & Outputs 

Florida 2020 Reports – 90.1 2016 AppG  

The generated Florida 2020 - 90.1 2016 AppG report from IESVE is shown below and should be located in the 

“PROJECTNAME\Content\Compliance Reports” directory for each building.    

 



 

 

 

 

 

Figure 7: Florida 2020 - 90.1 2016 AppG report 

To populate a new Florida 2020 - 90.1 2016 AppG report, a dialog is launched from IESVE Navigators, see 

below.  



 

 

 

  

Figure 8: Florida 2020 - 90.1 2016 AppG report in the Navigator 

  



 

 

 

Custom Hourly Analysis (VistaPro Application) 

IESVE software has a dedicated Application (VistaPro) for analysis of annual, monthly, daily, hourly and sub-

hourly results. Functionality of VistaPro includes graphical outputs (XY plots, bar charts, range tests of binned 

data, min/max peak graphs etc.) and data tables (annual hourly tables, monthly totals, etc.).  The data for 

analysis is commonly hourly annual energy simulation results, but can also be design heating & cooling loads, 

metered data or weather data. The VistaPro landscape image below details how various energy end-uses can 

be output (graphically or tabulated) and copied (red arrows) to external sources such as MS-Excel.  

  

Figure 9: Customized Analysis with the VistaPro Application 

1. VistaPro Application 

2. Results file selection. Note a ‘p_’ often represents a Proposed design and a ‘b_’ often represents a 

baseline/standard design. 

3. Category of analysis. Note the ‘Energy’ category selected and ‘Energy Breakdown’ tab for various 

energy end-uses and meters 

4. 8,760 hourly data tables; requires some energy end-uses to be selected.  

5. Monthly and annual data tables; requires some energy end-uses to be selected. 

6. Stacked bar-charts of energy end-uses.  

7. Calendar selection.  

Note that while other energy end-uses are shown E.g. exterior lighting and energy generated end-uses are 

shown in the design, they are excluded from the Savings By Design script & report.  The Savings By Design 

script/report only reads Space Heating Gas, Space Heating Electricity, Space Cooling, Fans Interior, Heat 

Rejection, Pumps, DHW Gas, DHW Electricity, Interior Lighting, Receptacle, Data Center, Cooking Gas, Cooking 

Electricity, Elevators, Refrigeration and Process.  



 

 

 

General Navigator Inputs – Integrated Communication/Narrative 

It is common for an end-user to use a Navigator in IESVE software, to streamline the workflow of a project, from 

top to bottom. Commonly used IESVE Navigators include IECC and ASHRAE 90.1 workflows, and are available 

for selection in Item 01 below. If a notepad icon is colored in (item 04), that means that there are explanatory 

notes within the model, beside that associated action or input, which is normally attempting to communicate 

the approach taken, or provide details about those specific model inputs, that are assigned to the model. These 

notes can be valuable to any reviewer, as separate narrative documentation might not be necessary. Various 

examples (item 02 – item 07) are shown below.   

Note that usage of an ASHRAE-based Navigator does not mean that the baseline model is an ASHRAE baseline.  

 

 
Figure 10: IES Navigator with Notes for Reviewer 



 

 

 

Geometry 

To view model geometry in a 3D viewer, see item 01 below. Note that all IESVE geometry is spatially aware of 

its surroundings, local shading and internal adjacencies. In order to confirm model orientation, select item 02.  

The major advantage of the 3D model is that the architecture (geometry) of the building can provide energy 

savings against the baseline model. This can come from an optimized orientation, intelligent fenestration 

placement, external shading devices (e.g. overhangs) and well-daylit spaces with integrated daylight controls.  

  

Figure 11: Proposed/Baseline Model Viewer 

There are two model approaches for comparing a proposed and standard (baseline) model.  

1. Host the two models in one model file. This is the most common approach, so if a Title 24 baseline 

model needs to be viewed, go to the View menu and select PRM Baseline. Note that the “PRM Baseline” 

geometry can represent any Baseline model (e.g. Title 24, ECB, etc.) and will have been modified by the 

user to represent the appropriate baseline code.  

2. Separate proposed and standard (baseline) models in two model files. This is less common, but can be 

common when underfloor systems are being compared.  

Weather 

Before validating the weather data used for a model, ensure California weather files are accessible within IESVE 

software by following the process described in the Step 2: Weather File Directory section of this document.  



 

 

 

The weather data referenced by a model can be viewed & edited from ApacheLocate (ApLocate).  ApLocate can 

be accessed by double clicking on the globe icon in the bottom right corner of IESVE software and the weather 

file used for simulations can be seen on the Simulation Weather Data tab within ApLocate: 

 

Figure 12: ApLocate and Simulation Weather File 

  

Envelope 

Follow actions 01-05 below to review construction assignments and assemblies for proposed and standard 

(baseline) models.  

 

Figure 13: Building Envelope Assignment Review 



 

 

 

To review any construction assembly, the appropriate construction can be selected and Edit construction to 

review.  

  

Figure 14: Model Constructions Review 

An example glazed assembly is shown below, which includes information about u-value (with/without frame), 

Solar Heat Gain Coefficient (SHGC) and Visible Light Transmittance (VLT). Dynamic shades can be viewed in the 

Shading Device tab below.   

  

Figure 15: Glazed Assembly Characteristics 



 

 

 

An example opaque construction assembly is shown below.  

 

Figure 16: Opaque Construction Assembly Characteristics 

 

An alternative review of constructions assignment can be made in the Apache Application or the ASHRAE 90.1 

Application, using the Input Data Visualization tool, as shown below. In this example, Constructions is the 

category and variable selected to be visualized.  

 

Figure 17: Input Data Visualization 



 

 

 

Many other variables can be visualized in this way, including internal gains (e.g. Lighting power density) and 

room conditions (e.g. heating setpoints).   



 

 

 

Internal Gains 

To review any occupancy gains, receptacle equipment (Plug Loads), lighting gains, refrigeration, cooking, data 

center gains, other process gains; schedules and diversity factors of internal gains for proposed and standard 

(baseline) models, open the Tabular Space Data dialog.  

 

Figure 18: Proposed/Baseline toggle for Internal Gains Review 

Action item 04 above will launch the Tabular Space Data dialog, as shown below.  

  

Figure 19: Tabular Data of Space Internal Gains Inputs 



 

 

 

Internal lighting gains (W/ft2) may be automatically split into separate daylight zones, depending upon model 

geometry (sidelit areas, skylit areas, etc.) and may be controlled by dynamic daylight sensors, linked to the 

RadianceIES daylight simulation engine.  

 

Miscellaneous Gains (e.g. elevators)  

To review miscellaneous energy consumption (elevators, exterior lights, etc.) select the Miscellaneous Energy 

Consumption feature.  

  

Figure 20: Miscellaneous Energy Consumption Review 

Miscellaneous energy consumption types may have alternatively been setup through the Building Template 

Manager / Internal Gains from the Tools menu.   



 

 

 

HVAC Systems 

To review the mechanical systems for both proposed and standard building models, go to ApacheHVAC and 

open the “Baseline.asp” file and/or the “Proposed.asp” file.  

   

Figure 21: Opening an HVAC File in ApacheHVAC 

The same can be done for the “Proposed.asp” file.   

There are a number of autosized prototypical HVAC systems available in ApacheHVAC for the proposed case. 

They include, though are not limited to: Package Terminal Air-Conditioners, Package Terminal Heat Pumps, 

Package Single-Zone Systems, Package Single-Zone Heat Pumps, VAV with Reheat, Indirect/Direct Evaporative 

Cooling VAV systems, VAV with Parallel Fan-Powered boxes, VAV with Series Fan-Powered boxes, Natural 

Ventilation or Mixed-mode VAV systems, VAV single-fan dual-duct systems, VAV dual-fan dual-duct systems, 

Underfloor air with Displacement Ventilation, Advanced VAV systems, Constant-volume reheat systems, with 

nighttime airflow setback, demand-controlled ventilation, Dedicated Outside Air Systems with Fan-coil units, 

Dedicated Outside Air Systems with water-loop heat pumps, DOAS with Active chilled beams (2 pipe),  DOAS 

with Active chilled beams (4 pipe),  Radiant Heating/Cooling panels with DCV, heating & ventilation only, DOAS 

with Air-source VRF, DOAS with Water-source VRF and any customizable HVAC system.   

Features of any customizable HVAC systems can include airside or waterside economizers, pre-heating and pre-

cooling devices, ground-source heat pumps, solar HW heat recovery, solar Trombe walls, earth tubes and wind-

catcher devices.  

  



 

 

 

Once the HVAC system is open in ApacheHVAC, the name of the HVAC file is shown (tag 02) below and the name 

of the system type (tag 03) is also shown. ApacheHVAC is a component-based HVAC user-interface, whereby 

any component (fan, coil, etc.) can be viewed by double-clicking in order to review the performance parameters 

of the HVAC system components.  

 

Figure 22: HVAC File Review 

  



 

 

 

 

Space Heating (Gas & Electricity) 

In ApacheHVAC, there are two airside views for space heating equipment: 

1. Radiant heating components (e.g. radiant panels) 

2. Convective heating components (e.g. hot water coils) 

Radiant heating equipment on the airside view can be reviewed by double-clicking a room component: 

 

Figure 23: Radiant Heating Units Input Review  

Convective heating equipment on the airside view can be reviewed by double-clicking a coil component:  

  

Figure 24: Heating Coil Review 



 

 

 

Both radiative and convective airside components will reference a heat source. This can be electricity (e.g. 

electric resistance heating coil) or can be Space Heating source equipment plant (e.g. gas furnace, heat pumps, 

hydronic hot water plant – boilers, etc.).  Opening an airside coil will allow the waterside-source to be reviewed. 

The example below shows two boilers, with a primary/secondary loop configuration and three secondary hot 

water loops with independent control for heating coils, radiant panels and a DHW tank. 

   

Figure 25: Hot Water Loop Review 

Heating equipment performance sets and efficiencies are editable for review: 

 



 

 

 

Figure 26: Heating Equipment Efficiencies and Performance Curve Data 

Space Cooling  

In ApacheHVAC, there are two airside views for space cooling equipment: 

1. Radiant cooling components (e.g. radiant panels) 

2. Convective cooling components (e.g. chilled water coils) 

Radiant cooling equipment on the airside view can be reviewed by double-clicking a room component: 

  

Figure 27: Radiant Cooling Units Input Review 

Convective cooling equipment on the airside view can be reviewed by double-clicking a coil component: 

  



 

 

 

Figure 28: Cooling Coil Review 

Both radiative and convective airside components will reference a cooling source. This can be electricity (e.g. 

electric evaporative-cooling spray chamber) or can be Space Cooling source equipment plant (e.g. DX cooling, 

heat pumps, dedicated waterside economizer, hydronic chilled water plant – chillers, etc.).  Opening an airside 

coil will allow the waterside-source to be reviewed. The example below shows two  

 

Figure 29: Chilled Water Loop Review 

Water Cooled Chiller equipment performance sets and efficiencies are editable for review: 

    



 

 

 

Figure 30: Water Cooled Chiller Review - Efficiency and Performance Curve Data 

Air Cooled Chiller equipment performance sets and efficiencies are editable for review: 

  

Figure 31: Air Cooled Chiller Review - Efficiency and Performance Curve Data 

DX Cooling & Unitary Cooling equipment performance sets and efficiencies are editable for review:  

 

Figure 32: DX & Unitary Cooling Equipment Review - Efficiency and Performance Curve Data 



 

 

 

Fans Interior 

In ApacheHVAC, the Fan inputs are editable for review by opening the fan components.  

  

Figure 33: Fan Input 

In VistaPro, total or individual Fan outputs can be reviewed by selecting the appropriate simulation result file 

and fan(s) components.  

  

Figure 34: Fan Output 



 

 

 

Heat Rejection 

In ApacheHVAC, the Heat Rejection inputs are editable for review by opening the waterside view, see below. 

Note there may also be some Heat Rejection inputs associated to non-waterside components, e.g. DX cooling.  

  

Figure 35: Cooling Tower Inputs 

There is also a possibility of some Heat Rejection coming from a pre-cooling device, as below.  

  

Figure 36: Fluid Cooler Input (as Heat Recovery) 

  



 

 

 

Pumps 

In ApacheHVAC, the Pumps inputs are editable for review by opening the Pumps components in the Waterside 

view. The pumps may exist on both heating and cooling systems.   

 

Figure 37: Pumps Input 

In VistaPro, total or individual Pumps outputs can be reviewed by selecting the appropriate simulation result 

file and pump(s) components.  

 

Figure 38: Pumps Output 

  



 

 

 

DHW (Gas & Electricity) 

In ApacheHVAC, the DHW inputs are editable for review by opening the DHW Loop from the toolbar below. The 

DHW (Gas & Electricity) on models previous to IESVE-2018 will likely be set in the Building Template Manager 

(Tools menu).  

 

Figure 39: DHW in ApacheHVAC 

 

Figure 40: DHW Inputs including Solar Hot Water Pre-heat 



 

 

 

3. Resources 

Links and references to several resources have been provided in this guide.  A summary of those references is 

provided here: 

• IES software engine validation resources  

http://www.iesve.com/software/software-validation 

• IES <Virtual Environment> software download  

http://iesve.com/software/download 

• IES <Virtual Environment> software license request 

http://www.iesve.com/software/download/requesting_licence_keys.pdf  

• IES Content Store (for supplemental scripts) 

http://www.iesve.com/content-store/    

• IESVE youTube videos 

https://www.youtube.com/user/IESVE 

IES offers many additional resources that may be useful when evaluating project specifics within a model.  User 

guides describe the details of the various applications within the VE, explaining how features work and 

describing how calculations are performed.  The IES Knowledge Base contains answers to our Frequently Asked 

Questions as well as guidance documents (like this one!) on a wide range of VE and modeling related topics.  

Finally, our global technical support team is available to answer any software related questions. 

User Guides 

User guides for the applications within the <Virtual Environment> can be found in a searchable, online format 

at https://help.iesve.com/ve2018/.   

To download PDF copies of older User Guides (prior to the release of VE 2018), visit 

http://www.iesve.com/support/userguides.  

Technical Support 

The IES Support Team is happy to assist with any question regarding the <Virtual Environment>.  They can be 

contacted via email at support@iesve.com or via phone at 617-502-2085 (choose option 1 for software support).  

When sending email queries about a specific project, please attach a model archive (the *.cab file) so the team 

can assist you more effectively. 

Knowledge Base 

The full breadth of IES resources and product supporting content is searchable within the Knowledge Base at 

http://www.iesve.com/support/knowledgebase.   

An online community of VE users share experiences and answer software questions on the IES Forums and the 

IES VE LinkedIn Group.  

 

http://www.iesve.com/software/software-validation
http://iesve.com/software/download
http://www.iesve.com/software/download/requesting_licence_keys.pdf
http://www.iesve.com/content-store/
https://help.iesve.com/ve2018/
http://www.iesve.com/support/userguides
mailto:support@iesve.com
http://www.iesve.com/support/knowledgebase
http://forums.iesve.com/
https://www.linkedin.com/groups/1911941


 

  


